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1.SIMULATION 
Project 1 of 7: Observation 
 
Overview 
You are a member of the Barstow College Observation Project committee. You are preparing the initial 
summary report for this year’s count, but have not received all of the data you need to complete the 
report. 

 

 
Introduction 
The multi-departmental Wildlife Observation Project has completed its wildlife population counts for this 
year. The counts were made between May 5 and May 7 for both the wilderness and cultivated land areas. 
This is in line with the count periods for all previous years. The species used for the counts have been 
identified as common for the region (central Missouri) in which the counts were taken. (Author, 2009) 
As in previous years, five observation blinds were set up two weeks before the counts were to take place. 
Counters worked eight-hour shifts providing 24-hour coverage of the count areas for two days. Weather 
for both observation days was clear and mild (varying between 50-70 degrees F). 
The results presented here are summary total results only, which counts from five and ten years ago 
provided for comparison. Detailed observation results will be available as soon as they are completed. 
We estimate that they will be available some time in the next two weeks. 
 
Wilderness Summary 
The wilderness observation area is a five-acre section of unimproved forest land. The most common trees 
in the area are maple, red oak, cedar, sweet gum, and hickory. The area also includes a small spring. The 
area is not enclosed by a fence or other man-made barrier. The area is located eight miles from the 
nearest paved road and twelve miles from the nearest residence. Offroad vehicles were used to bring 
counters close to, but not entering, the count area. The nearest approach by off-road vehicles was one 
mile. 
The table below lists the summary counts. 
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Though further research any analysis is needed, the drop in mourning dove and bobwhite quail counts 
could be significant. The detailed count data shows these numbers failing off each year. 
 
Cultivated Land Summary 
The cultivated land observation area is a five-acre section of cultivated land near the center of a 50-acre 
field. The field is used to grow corn, wheat, soybeans, and clover, with the crop rotated annually. In the 
fifth year of the cycle, the field is left fallow. 
The area is located two miles from the nearest paved road and one mile from the nearest residence. A 
storage barn is located at the southern border of the field. 
The table below lists the summary counts. 
 
Additional Notes 
This project was initially scheduled to run for ten years, so we are currently in our last year. The 
committee needs to decide if it is worth the time and expense to continue the project. The landowners 
have experience that they would be happy to let us continue. Costs relating to the project is minimal and it 
does provide an opportunity to offer extra credit to students volunteering as counters. 
A suggestion has been made by some committee members that we should increase the count frequency, 
counting on a quarterly schedule instead of an annual schedule. This would need to be coordinated with 
the owner of the cultivated field so that we do not interfere with planting or harvesting schedules. 
 
Special Thanks 
Once again, we would like to offer special thanks to: 
We couldn’t do this without you. 
Add a table with eight rows and four columns in the “Cultivated Land Summary” section, below the text 
“The table below lists the summary counts.” 
Answer: 
1. Click below the text “The table below lists the summary counts.” where the table should be inserted. 
2. Select Table from the Insert tab. 
3. Drag through the grid to set eight rows and four columns (4x8 Table) as desired OR 
1. Click below the text “The table below lists the summary counts.” where the table should be inserted. 
2. Select Table from the Insert tab. 
3. Select Insert Table from the options provided below and type four columns and eight rows in the 
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appropriate boxes, then select OK. 
References: 
https://support.office.com/en-us/article/Insert-a-table-A138F745-73EF-4879-B99A-2F3D38BE612A 
 
2.SIMULATION 
Project 1 of 7: Observation 
 
Overview 
You are a member of the Barstow College Observation Project committee. You are preparing the initial 
summary report for this year’s count, but have not received all of the data you need to complete the 
report. 

 

 
Introduction 
The multi-departmental Wildlife Observation Project has completed its wildlife population counts for this 
year. The counts were made between May 5 and May 7 for both the wilderness and cultivated land areas. 
This is in line with the count periods for all previous years. The species used for the counts have been 
identified as common for the region (central Missouri) in which the counts were taken. (Author, 2009) 
As in previous years, five observation blinds were set up two weeks before the counts were to take place. 
Counters worked eight-hour shifts providing 24-hour coverage of the count areas for two days. Weather 
for both observation days was clear and mild (varying between 50-70 degrees F). 
The results presented here are summary total results only, which counts from five and ten years ago 
provided for comparison. Detailed observation results will be available as soon as they are completed. 
We estimate that they will be available some time in the next two weeks. 
 
Wilderness Summary 
The wilderness observation area is a five-acre section of unimproved forest land. The most common trees 
in the area are maple, red oak, cedar, sweet gum, and hickory. The area also includes a small spring. The 
area is not enclosed by a fence or other man-made barrier. 
The area is located eight miles from the nearest paved road and twelve miles from the nearest residence. 
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Offroad vehicles were used to bring counters close to, but not entering, the count area. The nearest 
approach by off-road vehicles was one mile. 
The table below lists the summary counts. 

 
Though further research any analysis is needed, the drop in mourning dove and bobwhite quail counts 
could be significant. The detailed count data shows these numbers failing off each year. 
 
Cultivated Land Summary 
The cultivated land observation area is a five-acre section of cultivated land near the center of a 50-acre 
field. The field is used to grow corn, wheat, soybeans, and clover, with the crop rotated annually. In the 
fifth year of the cycle, the field is left fallow. 
The area is located two miles from the nearest paved road and one mile from the nearest residence. A 
storage barn is located at the southern border of the field. 
The table below lists the summary counts. 
 
Additional Notes 
This project was initially scheduled to run for ten years, so we are currently in our last year. The 
committee needs to decide if it is worth the time and expense to continue the project. The landowners 
have experience that they would be happy to let us continue. 
Costs relating to the project is minimal and it does provide an opportunity to offer extra credit to students 
volunteering as counters. A suggestion has been made by some committee members that we should 
increase the count frequency, counting on a quarterly schedule instead of an annual schedule. This would 
need to be coordinated with the owner of the cultivated field so that we do not interfere with planting or 
harvesting schedules. 
 
Special Thanks 
Once again, we would lik to offer special thanks to: 
We couldn’t do this without you. 
Merge all cells in the bottom row of the table below the “Wilderness Summary” heading into one cell. 
Answer: 
1. Select the cells in the bottom row of the table below the “Wilderness Summary” which you want to 
merge. 
2. Under Table Tools, on the Layout tab, in the Merge group, select Merge Cells. 
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OR 
1. Select the cells in the bottom row of the table below the “Wilderness Summary” which you want to 
merge. 
2. Right click and select Merge Cells. 
References: 
https://support.office.com/en-us/article/Merge-or-split-cells-in-a-table-8B458DEB-0FC5-4C8D-8D94-2D4
DA98193F8 
 
3.SIMULATION 
Project 1 of 7: Observation 
 
Overview 
You are a member of the Barstow College Observation Project committee. You are preparing the initial 
summary report for this year’s count, but have not received all of the data you need to complete the 
report. 

 

 
Introduction 
The multi-departmental Wildlife Observation Project has completed its wildlife population counts for this 
year. The counts were made between May 5 and May 7 for both the wilderness and cultivated land areas. 
This is in line with the count periods for all previous years. The species used for the counts have been 
identified as common for the region (central Missouri) in which the counts were taken. (Author, 2009) 
As in previous years, five observation blinds were set up two weeks before the counts were to take place. 
Counters worked eight-hour shifts providing 24-hour coverage of the count areas for two days. Weather 
for both observation days was clear and mild (varying between 50-70 degrees F). 
The results presented here are summary total results only, which counts from five and ten years ago 
provided for comparison. Detailed observation results will be available as soon as they are completed. 
We estimate that they will be available some time in the next two weeks. 
 
Wilderness Summary 
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The wilderness observation area is a five-acre section of unimproved forest land. The most common trees 
in the area are maple, red oak, cedar, sweet gum, and hickory. The area also includes a small spring. The 
area is not enclosed by a fence or other man-made barrier. 
The area is located eight miles from the nearest paved road and twelve miles from the nearest residence. 
Offroad vehicles were used to bring counters close to, but not entering, the count area. The nearest 
approach by off-road vehicles was one mile. 
The table below lists the summary counts. 

 
Though further research any analysis is needed, the drop in mourning dove and bobwhite quail counts 
could be significant. The detailed count data shows these numbers failing off each year. 
 
Cultivated Land Summary 
The cultivated land observation area is a five-acre section of cultivated land near the center of a 50-acre 
field. The field is used to grow corn, wheat, soybeans, and clover, with the crop rotated annually. In the 
fifth year of the cycle, the field is left fallow. 
The area is located two miles from the nearest paved road and one mile from the nearest residence. A 
storage barn is located at the southern border of the field. 
The table below lists the summary counts. 
 
Additional Notes 
This project was initially scheduled to run for ten years, so we are currently in our last year. The 
committee needs to decide if it is worth the time and expense to continue the project. The landowners 
have experience that they would be happy to let us continue. Costs relating to the project is minimal and it 
does provide an opportunity to offer extra credit to students volunteering as counters. 
A suggestion has been made by some committee members that we should increase the count frequency, 
counting on a quarterly schedule instead of an annual schedule. This would need to be coordinated with 
the owner of the cultivated field so that we do not interfere with planting or harvesting schedules. 
 
Special Thanks 
Once again, we would like to offer special thanks to: 
We couldn’t do this without you. 
Add a Status of “Requires committee review” to the document properties. 
Answer: 
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1. Select the File tab and select Info. 
2. Click on Properties at the top of the page and then select Advanced Properties. 
3. Select the Custom tab. 
4. In the Name box, select or type a name for the custom property, in this case it would be “Status”. 
5. In the Type list, select “Text”. 
6. In the Value box, type “Requires committee review”, then click OK. 
References: 
https://support.office.com/en-us/article/View-or-change-the-properties-for-an-Office-file-21D604C2-481E-
4379-8E54-1DD4622C6B75 
 


